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NEW QUESTION 1
You have a dashboard that shows car rental statistics by city, including a field named Car Dropoff City in the view. A URL action in the dashboard uses
https://en.wikipedia.org/wiki/<Car Dropoff City> as the URL target.
When you click Salt Lake City in the view, to where will the URL action direct you?

A. https://en.wikipedia.org/wiki/<Car Dropoff City>
B. https://en.wikipedia.org/wiki/<Salt-Lake-City>
C. https://en.wikipedia.org/wiki/Salt.LakeXity
D. https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City

Answer: D

Explanation: 
 When you click Salt Lake City in the view, the URL action will direct you to https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City. A URL action is a
hyperlink that points to a web page or other web-based resource outside of Tableau. You can use URL actions to create an email or link to additional information
about your data. To customize links based on your data, you can automatically enter field values as parameters in URLs3 In this case, the URL action uses
https://en.wikipedia.org/wiki/<Car Dropoff City> as the URL target, where <Car Dropoff City> is a field value from the view. When you click Salt Lake City in the
view, Tableau will replace <Car Dropoff City> with Salt Lake City in the URL target. However, since spaces are not allowed in URLs, Tableau will encode them as
+ signs instead. Therefore, the final URL will be https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City3 The other options are not correct because they do
not reflect how Tableau encodes field values in URL actions.

NEW QUESTION 2
Suppose you create a bar chart by dragging a dimension to the Column shelf and a measure to the Rows shelf. Which of the following would create a stacked bar
chart?

A. By dragging another dimension to the Rows shelf
B. By dragging another measure to Color on the Marks card
C. By dragging another dimension to Color on the Marks card
D. By dragging another measure to the Columns shelf

Answer: C

Explanation: 
 Very important question for the exam and appears quite a lot too.
The correct answer is - By dragging another dimension to Color on the Marks card.

This is what the question says we have already created. Now to convert this into a Stacked bar chart, we will drop another dimension on Color in the Marks card.

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full TDS-C01 dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/TDS-C01-exam-dumps.html (314 New Questions)

The rest won't create stacked bar charts, and hence are incorrect choices. The best way to answer such questions on the real exam is to quickly do what the
options say and see if
they satisfy the requirements in the question.

NEW QUESTION 3
By definition, Tableau displays measures over time as a ______

A. Packed Bubble
B. Bar
C. Stacked Bar
D. Line

Answer: D

Explanation: 
 Line charts connect individual data points in a view. They provide a simple way to visualize a sequence of values and are useful when you want to see trends over
time, or to forecast future values.
Please refer to the images below:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/buildexamples_line.htm

NEW QUESTION 4
Which of the following are valid ways to trigger actions for a Dashboard?

A. Hover
B. Click
C. Select
D. Menu
E. Double click

Answer: ACD

Explanation: 
Explanation
Whenever we want to add actions to a Dashboard, we can trigger then in the following 3 ways:
1) Select
2) Hover
3) Menu
Hover is best for highlighting, select for filtering. Menu action is added to the tooltip and user can decide whether to run that action or not (best for URL actions)

Reference: https://help.tableau.com/current/pro/desktop/en-us/actions_dashboards.htm

NEW QUESTION 5
True or False: Enabling any other type of sort (Field, alphabetic, or Nested) clears the manual sort we create.

A. True
B. False

Answer: A

Explanation: 
 This is true. a Manual Sort lets you select a value and move it to the desired position, either by dragging it in the list or using the arrows to the right.
However, as soon as you choose some other type of sort - be it field, nested, or alphabetic, our custom created manual sort gets deleted/cleared.
Reference: https://help.tableau.com/current/pro/desktop/en- us/sortgroup_sorting_computed_howto.htm

NEW QUESTION 6
What are three ways to access bolding options for the text in a tooltip? Choose three.

A. Select Tooltip on the Marks card.
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B. Select Format on the menu, and then select Font
C. Select Worksheet on the menu, and then select Tooltip
D. Hover over a mark and press CTRL+B.
E. Hover over a mark and press ALT+F.
F. Right-click on the Field and select Format.

Answer: ACF

Explanation: 
 To access bolding options for the text in a tooltip in Tableau, you can:
? Select Tooltip on the Marks card, which allows you to edit the tooltip for the specific marks.
? Select Worksheet on the menu, and then Tooltip, to open the tooltip editor for the worksheet.
? Right-click on the Field and select Format, which lets you format the text including bolding options in the tooltip.

NEW QUESTION 7
Which of the following is the correct way to calculate Profit Ratio in Tableau?

A. Profit / Sales
B. Sales / Profit
C. SUM(Profit) / SUM(Sales)
D. SUM(Sales)/SUM(Profit)

Answer: C

Explanation: 
THIS IS A VERY IMPORTANT QUESTION
Aggregation is an important concept to consider when creating calculated fields. A calculated field for SUM([Profit]) / SUM([Sales]) will give you a very different
answer than [Profit] / [Sales], even though both formulas are valid.
If you do not provide the aggregation within the calculated field, Tableau will calculate the equation for every record ( row ) in your analysis, then aggregate the
answers for all of the rows together when the calculated field is added to the view.
In simple terms, if specify the aggregation such as SUM, what Tableau will do is that it will first calculate the sum of the Profit column ( say x ), then calculate the
sum of the Sales column ( say y ), and then simply apply x/y ---> This is what we expect! Perfect!
BUT, if you don't specify the aggregation, it will go to every single ROW, perform Profit / Sales, and then aggregate the answers calculated for each row. This is
simply NOT what we wan't!
An example:

Reference: https://www.linkedin.com/pulse/tableau-tip-dont-make-error-ratio-calculations- bob-newstadt

NEW QUESTION 8
Which of the following points are True about Viz Animations?

A. Sequential animations take more time but make complex changes clearer by presenting them step-by-step
B. They can be turned on for certain worksheets only
C. Animations work well with maps, polygons, and density marks in web browsers
D. It is possible to turn them on for the entire workbook at once

Answer: ABD

Explanation: 
All of the given options are true except - Animations work well with maps, polygons, and density marks in web browsers.
From the official documentation:
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As seen above, we can either turn the animations for the entire workbook (upper red box), or only for the current sheet ( lower red box )
1) Simultaneous animations
The default simultaneous animations are faster and work well when showing value changes in simpler charts and dashboards.
2) Sequential animations
Sequential animations take more time but make complex changes clearer by presenting them step-by-step.
Reference: https://help.tableau.com/current/pro/desktop/en-us/formatting_animations.htm

NEW QUESTION 9
In order to avoid any confusions, what should you do after creating a Dual-axis chart?

A. Hide the axis
B. Change the colours
C. Synchronise the axis
D. Edit the labels

Answer: C

Explanation: 
 After creating a dual axis chart, make sure to synchronise their axis since they both might not be having the same y-axis.
To align the two axes in a dual axes chart to use the same scale, right-click (control-click on Mac) the secondary axis, and select Synchronize Axis. This aligns the
scale of the secondary axis to the scale of the primary axis.
In this example, the Sales axis is the secondary axis and the Profit axis is the primary axis. If you would like to change which axis is the primary, and which axis is
the secondary, select the field on the Columns or Rows shelf that is the secondary, and drag it in front of the primary field on the shelf until you see an orange
triangle appear.
In this example, you can select the SUM(Sales) field on the Rows shelf, and drag it in front of the SUM(Profit) field. The Sales axis is now the primary and the
Profit axis is the secondary.

Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_measures.htm

NEW QUESTION 10
You need to access options to change a dimension's color palette. In addition to the Marks card, what else can you use?

A. The Color legend
B. Edit in Shelf
C. The Format menu
D. Edit Caption

Answer: A
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Explanation: 
 You can use the Color legend to access options to change a dimension’s color palette, in addition to the Marks card. The Color legend shows the colors assigned
to each member of the dimension in the view. You can right-click on the Color legend and select Edit Colors to open the Edit Colors dialog box, where you can
change the color palette, assign specific colors to dimension members, or edit the color transparency and border6 The other options are not valid ways to change
a dimension’s color palette. Edit in Shelf is a feature that allows you to edit the fields on the Rows or Columns shelves by typing directly on the shelf. It does not
affect the color palette of the dimension7 The Format menu allows you to change the appearance of various elements in the workbook, such as fonts, borders,
shading, alignment, etc. It does not have options for changing the color palette of the dimension8 Edit Caption is a feature that allows you to add or edit a caption
for a worksheet or dashboard. It does not affect the color palette of the dimension

NEW QUESTION 10
True or False: To concatenate fields, they must be of same data type

A. True
B. False

Answer: A

Explanation: 
 Yes! To concatenate fields, they must be of same data type. However, there is a workaround which we can use - Type casting. See below:

Here, State and City are Strings, but Postal Code? Nope. It's an Integer. So we can simply use the STR() function to convert it into a String, and hence the entire
equation becomes valid!

NEW QUESTION 15
Our use case states that we need to create a set showing the Bottom 10 products by Profit in each Region. Which of the following filter types should you apply on
Region?

A. Measure Filters
B. Context Filters
C. Extract Filters
D. Dimension Filters

Answer: B

Explanation: 
The beauty of context filters is that according to Tableau's Order of Operations, they are executed before Sets.

This means that based on what Region's you've selected - Tableau will first only preserve the rows for those Regions. THEN, after this it will compute the Set , i.e ,
Bottom 10 products in each Region.
1) First let's create a set to compute the Bottom 10 Products by Profit.

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full TDS-C01 dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/TDS-C01-exam-dumps.html (314 New Questions)

2) Next, take region on the Rows Shelf followed by the Set we just created. Drag Region and the Set to the Filters Shelf as well.

3) Now, try to only visualize the data for the South Region:

4) The problem right now is that Tableau is computing the Set first (Bottom 10 Products), and then applying the Dimension Filter - South Region and hence these
values are incorrect. Note how these aren't even 10 products, but rather just 8. To fix this, simply add Region to Context:
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Upon doing this, we get the correct answer as :

References: https://help.tableau.com/current/pro/desktop/en-us/order_of_operations.htm https://help.tableau.com/current/pro/desktop/en-us/filtering_context.htm

NEW QUESTION 16
A union of two tables usually results in an

A. decrease in the number of rows
B. increase in the number of rows
C. decrease in the number of columns
D. increase in the number of columns

Answer: B

Explanation: 
From the official Tableau documentation:
You can union your data to combine two or more tables by appending values (ROWS) from one table to another. To union your data in Tableau data source, the
tables must come from the same connection.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/union.htm

NEW QUESTION 19
How do you identify a continuous field in Tableau?

A. It is identified by a blue pill in the visualization
B. It is identified by a green pill in a visualization
C. It is preceded by a '=#' symbol in the data window
D. It is preceded by a 'Abc' symbol in the data window

Answer: B

Explanation: 
 When you connect to a new data source, Tableau assigns each field in the data source as dimension or measure in the Data pane, depending on the type of data
the field contains. You use these fields to build views of your data.

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 24
Which two filter modes can you use with dimension filters? Choose two

A. Multiple Values (drop-down)
B. At most
C. Wildcard Match
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D. Range of Values

Answer: AC

Explanation: 
 With dimension filters in Tableau, you can use several filter modes, including "Multiple Values (drop-down)" which allows users to select one or more values from
a drop- down list of all the dimension's members. Another mode is "Wildcard Match," which lets users filter the view by typing in a text box to match dimension
members that contain the typed string. These filter types are particularly useful for string or categorical dimensions where users need to search or select specific
members to display in the view.

NEW QUESTION 29
At a minimum, what do you need to create a simple scatter plot?

A. A measure on Columns and a measure on Rows
B. A dimension on Detail and a measure on Columns
C. A dimension on Columns and a measure on Rows
D. A dimension on Columns and a dimension on Rows

Answer: A

Explanation: 
 To create a simple scatter plot in Tableau, you need to have a measure on Columns and a measure on Rows. A scatter plot is a type of visualization that shows
the relationship between two numerical variables. In Tableau, you can create a scatter plot by placing at least one measure on the Columns shelf and at least one
measure on the Rows shelf. The measures can be continuous or discrete, but they must be aggregated. The marks in the scatter plot represent the intersection of
the values for each measure1 The other options are not valid ways to create a simple scatter plot in Tableau. A dimension on Detail and a measure on Columns
will create a bar chart, not a scatter plot. A dimension on Columns and a measure on Rows will create a line chart or an area chart, depending on the mark type. A
dimension on Columns and a dimension on Rows will create a text table or a heat map, depending on the mark type1

NEW QUESTION 34
What is the minimum amount of RAM recommended for any production use of Tableau
Server?

A. 8GB
B. 16GB
C. 32GB
D. 64GB

Answer: B

Explanation: 
 The computer on which you are installing or upgrading Tableau Server must meet the minimum hardware requirements. If the Setup program determines that your
computer does not meet the following requirements, you will not be able to install Tableau Server. These minimum requirements are appropriate for a computer
that you use for prototyping and testing of Tableau Server. They apply to single-node installations and to each computer in a distributed installation.

Reference: https://help.tableau.com/current/server/en-us/server_hardware_min.htm

NEW QUESTION 38
Using the CoffeeChain table, create a Dual Axis chart showing the Sales (Bar chart) and Profit (Line Chart) for each Product type. What was the Profit for the
Herbal Tea product type in 2013?

A. 68,620
B. 74,683
C. 37,455
D. 46,493

Answer: C

Explanation: 
 If you answered this question quickly and correctly, you're well prepared for the exam! Most students stumble while creating a Dual axis chart, so go ahead and
give yourself a pat on the back!
To create a dual axis chart for the problem mentioned:
1) Drag Product Type to the column shelf, and Sales and Profit to the Row shelf:
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2) Now, to focus on 2013, drag Date to the filter shelf and select only 2013:

3) Now, click on the Profit pill in the Rows Shelf, and select dual axis:

4) Now, in the marks shelf, choose Sales, and change the chart type to bar. Similarly, for Profit, change the chart type to Line.

Now the chart looks like this:
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Now we change the Profit chart type to line:

5) Finally, we synchronise the axis as follows: Right click on the axis, and choose 'Synchronise axis'
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And, our final view and answer is:

NEW QUESTION 41
If you decide you want to see all of the marks in the view at the most detailed level of granularity, you can _______ the view.

A. sort the measures
B. disaggregate the measures
C. break-down the measures
D. aggregate the measures
E. split the measures

Answer: B

Explanation: 
 The different aggregations available for a measure determine how the individual values are collected: they can be added (SUM), averaged (AVG), or set to the
maximum (MAX) or minimum (MIN) value from the individual row values.

For a complete list of the available aggregations, check out - List of Predefined Aggregations in Tableau.
The level of detail is determined by the dimensions in your view—for information about the concept of level of detail, see How dimensions affect the level of detail in
the view. Disaggregating your data can be useful for analyzing measures that you may want to use both independently and dependently in the view. For example,
you may be analyzing the results from a product satisfaction survey with the Age of participants along one axis. You can aggregate the Age field to determine the
average age of participants or disaggregate
the data to determine at what age participants were most satisfied with the product.
Disaggregating data can be useful when you are viewing data as a scatter plot. See Example: Scatter Plots, Aggregation, and Granularity.
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Reference: https://help.tableau.com/current/pro/desktop/en- us/calculations_aggregation.htm

NEW QUESTION 42
What are three benefits of using an extract as compared to a live connection to a data source? Choose three.

A. A live connection to a data source can be slow due to network and user traffic, whereas a connection to an extract improves performance.
B. Extracts are stored in memory (RAM), resulting in faster query performance as compared with live data connections.
C. A live connection to a data source provides the best performance for data connections.
D. An extract reduces the amount of data stored on a client computer as compared to a live data connection.
E. Calculated fields perform better in workbooks connected to extracts than in workbooks with live connections to a data source.

Answer: ABE

Explanation: 
 There are three benefits of using an extract as compared to a live connection to a data source:
? A live connection to a data source can be slow due to network and user traffic,
whereas a connection to an extract improves performance. An extract is a snapshot of data that is stored locally on your computer or on Tableau Server. An
extract can reduce the load on the data source and speed up queries.
? Extracts are stored in memory (RAM), resulting in faster query performance as
compared with live data connections. When you use an extract, Tableau loads the data into memory and optimizes it for analysis. This allows Tableau to perform
calculations and aggregations faster than with live connections.
? Calculated fields perform better in workbooks connected to extracts than in
workbooks with live connections to a data source. Calculated fields are custom fields that you create using formulas or expressions. When you use an extract,
Tableau can process calculated fields more efficiently than with live connections.

NEW QUESTION 47
What does the box in a box plot represent?

A. Maximum value of the data
B. Minimum value of the data
C. The interquartile range
D. The median of the middle half of the data points

Answer: C

Explanation: 
 In a box and whisker plot:
1) The ends of the box are the upper and lower quartiles, so the box spans the interquartile range
2) The median is marked by a vertical line inside the box
3) The whiskers are the two lines outside the box that extend to the highest and lowest observations.

NEW QUESTION 49
True or False : Bins can be created on dimensions

A. False
B. True

Answer: B

Explanation: 
 Bin are a user-defined grouping of numerical data in the data source.
According to the official Tableau documentation: It's sometimes useful to convert a continuous measure (or a numeric dimension) into bins.
Have a look at the following image. When we right click a measure, we get the following options:
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However, for a dimension (this is because the DATA TYPE of this dimension is a string:

But what if we have a dimension of type NUMBER (NUMERIC DIMENSION)? See below:
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We can clearly create bins from dimensions too - they just have to be numeric :)
For more information, please refer to : https://help.tableau.com/current/pro/desktop/en- us/calculations_bins.htm

NEW QUESTION 53
You have a visualization that uses multiple types of sorting. How can you clear all sorting of the visualization?

A. Right-click a sorted field, and then select Clear Sort.
B. From the Dashboard menu, select Clear.
C. From the Header label, select the sort icon.
D. From the Worksheet menu, select Clear, and then select Sorts.

Answer: D

Explanation: 
 To clear all sorting in a Tableau visualization, you would go to the Worksheet menu, select the "Clear" option, and then choose "Sorts." This action removes all
sorting that has been applied to the visualization, including any custom sorting or sorting based on multiple fields. This is a quick way to reset the view to its default
sorting state and is particularly useful when you have applied various sorting layers and wish to start fresh.

NEW QUESTION 57
What are two use cases for creating hierarchies from the Data pane? Choose two.

A. To organize related fields together
B. To create faster-performing queries
C. To concatenate all fields into a single field
D. To add drilldown functionality for fields

Answer: AD

Explanation: 
 Hierarchies in Tableau are used to define a drill-down path through your data. By creating a hierarchy, you can organize related fields together, which makes it
easier to navigate complex data models. This also allows users to explore data at different levels of detail, from the highest level of the hierarchy to the most
granular details, simply by clicking to expand and collapse levels of the hierarchy in the view.

NEW QUESTION 58
Which of the following are True for Measure Names?

A. It contains all the measures in your data, collected into a single field with continuous values.
B. When you add it to a view, all of the measure names appear as row or column headers in the view.
C. When working with a text table showing Profit for each Category,when you add Sales to the text table (by dragging it and dropping it in the view), the measure
names field is automatically dragged to the row and filter shelves.
D. It contains the names of all measures in your data, collected into a single field with discrete values.

Answer: BCD

Explanation: 
 It contains all the measures in your data, collected into a single field with continuous values - This is the definition for 'Measure Values'.

All others are True w.r.t. Measure Names!
The Measure Names field contains the names of all measures in your data, collected into a single field with discrete values.
Documentation : https://help.tableau.com/current/pro/desktop/en- us/datafields_understanddatawindow_meavalues.htm

NEW QUESTION 59
What is the one critical difference between normal calculated fields, and the calculated fields created after Data blending?

A. No difference, calculated fields cannot be created in Blends
B. Fields used in Blends must first be aggregated
C. The calculated fields created in Blends cannot be edited once created
D. The calculated fields created in Blends cannot use more than 2 fields
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Answer: B

Explanation: 
Yes, due to the nature of blends, there are some conditions as follows from the official documentation that must be kept in mind while working with blends:

In addition to handling calculations slightly differently, there are some limitations on secondary data sources. You may not be able to sort by a field from a
secondary data source, and action filters may not work as expected with blended data. For more information, see Other data blending issues.
Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_connections.htm

NEW QUESTION 61
Which mark type is used in a highlight table?

A. Text
B. Square
C. Polygon
D. Area

Answer: B

Explanation: 
 According to the Tableau Help, a highlight table is “a cross-tabulation that uses color to encode values”. The help also states that “Highlight tables use the
Square mark type” (page 1).

NEW QUESTION 64
What is the one most important thing you should do after creating a Dual-axis chart?

A. Synchronise the axis
B. Change the colours
C. Edit the labels
D. Hide the axis

Answer: A

Explanation: 
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After creating a dual axis chart, make sure to synchronise their axis since they both might not be having the same y-axis.
To align the two axes in a dual axes chart to use the same scale, right-click (control-click on Mac) the secondary axis, and select Synchronize Axis. This aligns the
scale of the secondary axis to the scale of the primary axis.
In this example, the Sales axis is the secondary axis and the Profit axis is the primary axis. If you would like to change which axis is the primary, and which axis is
the secondary, select the field on the Columns or Rows shelf that is the secondary, and drag it in front of the primary field on the shelf until you see an orange
triangle appear.
In this example, you can select the SUM(Sales) field on the Rows shelf, and drag it in front of the SUM(Profit) field. The Sales axis is now the primary and the
Profit axis is the secondary.

Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_measures.htm

NEW QUESTION 65
True or False: It is possible to change the Geographic Role of a dimension

A. True
B. False

Answer: A

Explanation: 
 A geographic role associates each value in a field with a latitude and longitude value. Assigning a geographic role based on the type of location (such as state
versus postcode) helps ensure that your data is plotted correctly on your map view. For example, you can assign the City geographic role to a field that contains a
list of city names.
To assign a geographic role to a field:
In the Data pane, click the data type icon next to the field, select Geographic Role, and then select the geographic role you want to assign to the field.

When you assign a geographic role to a field, Tableau adds two fields to the Measures area of the Data pane: Latitude (generated) and Longitude (generated).
These fields contain latitude and longitude values and are assigned the Latitude and Longitude geographic roles. If you double-click each of these fields, Tableau
adds them to the Columns and Rows shelves and creates a map view using the Tableau background map.

Reference: https://help.tableau.com/current/pro/desktop/en-us/maps_geographicroles.htm

NEW QUESTION 67
If you use a percent difference Quick Table Calculation, what value will be the first data value?

A. null
B. -1
C. 0000

Answer: A

Explanation: 
 When using a Percent difference, Tableau calculates what the percent change has occured as compared to the last data value. BUT, for the first data value, there
is no previous value to compare it to. Hence, it appears as NULL.
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NEW QUESTION 68
You have cleaned a data source properly, created some calculated fields and renamed some columns. You want to save these changes for future use cases.
Which of the following would BEST satisfy this requirement?

A. Save it as a .twm file
B. Save it as a .twb file
C. Save it as a .tds file
D. Save it as a .twbx file

Answer: C

Explanation: 
 After making changes to Data, we can save that new data source as a .tds file. To do so,
go to data menu on top and then choose your current connected data source. Then next click on Add to Saved Data sources. This will save all calculated fields,
changes to fields etc. It will be saved in My Tableau Repository -> Mydatasources. This will then also appear on Tableau Home Page under saved data sources
like SampleSuperStore.
Note: Data source files do not contain the actual data but rather the information necessary to connect to the actual data as well as any modifications you've made
on top of the actual data such as changing default properties, creating calculated fields, adding groups, and so on.
twb and .twbx are not the BEST solutions since the questions nowhere mentions that we need to store our workbooks as well.
twm is a bookmark which contains a single worksheet and are an easy way to quickly share your work.
Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 70
How would you calculate GDP per capita in Tableau?

A. SUM([GDP]/[POPULATION])
B. SUM([Population]/[GDP]])
C. SUM([GDP]*[POPULATION])
D. SUM([GDP]) / SUM([Population])

Answer: D

Explanation: 
 GDP / Population = GDP Per Capita

Here Sum is a function, / and + are operators. On the bottom there are comments.

NEW QUESTION 74
Suppose you have a bar chart. When we group by labels in a view, which of the following happens?

A. Nothing changes in the view, but a group is created in the Dimensions shelf.
B. The colours of the members selected are now the same, and different for the rest of the members.
C. Trick question! It is not possible to group by labels.
D. A new mark (bar) is created, which consolidates all members of the group.
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Answer: D

Explanation: 
*Very important question*
If we select the labels in the view and then group, a new consolidated mark is created - in our case bar since we are talking about a bar chart in the question. See
below:

Then on grouping, a new bar is created, and the colour of all bars remain the same.

Had we grouped by choosing the marks instead of the labels, the following would be the result:
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Reference: https://help.tableau.com/current/pro/desktop/en- us/sortgroup_groups_creating.htm

NEW QUESTION 76
If you are working with a huge dataset, which of the following are strong reasons to use a context filter?

A. Improve query performance
B. To make the context filter a dependent filter
C. To help clean the data
D. To include only the data of interest

Answer: AD

Explanation: 
By default, all filters that you set in Tableau are computed independently. That is, each filter accesses all rows in your data source without regard to other filters.
However, you can set one or more categorical filters as context filters for the view. You can think of a context filter as being an independent filter (Option stating -
To create a dependent filter eliminated
here). Any other filters that you set are defined as dependent filters because they process only the data that passes through the context filter.
You may create a context filter to:
1) Improve performance – If you set a lot of filters or have a large data source, the queries can be slow. You can set one or more context filters to improve
performance.
2) Create a dependent numerical or top N filter – You can set a context filter to include only the data of interest, and then set a numerical or a top N filter.
For example, suppose you’re in charge of breakfast products for a large grocery chain.
Your task is to find the top 10 breakfast products by profitability for all stores. If the data source is very large, you can set a context filter to include only breakfast
products. Then you can create a top 10 filter by profit as a dependent filter, which would process only the data that passes through the context filter.
Reference: https://help.tableau.com/current/pro/desktop/en-us/filtering_context.htm

NEW QUESTION 79
When exporting a worksheet as an image in Tableau, which of the following file formats are available?

A. Portable Network Graphic (.PNG)
B. JPEG Image (.JPG, .JPEG)
C. Tagged Image File Format (TIFF)
D. Windows Bitmap (.BMP)

Answer: ABD

Explanation: 
The following options are available when an image is Exported:

NOTE: When we Copy an image rather than exporting it, then the image is copied to the clipboard in the TIFF file format! However, it is not available when
EXPORTING an image. Reference: https://help.tableau.com/current/pro/desktop/en-us/save_export_image.htm

NEW QUESTION 83
When using a Blend, what is the color of tick-mark on the primary and secondary data sources respectively?
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A. Red, Blue
B. Orange, Blue
C. Blue, Red
D. Blue, Orange

Answer: D

Explanation: 
 When using a Blend, the primary data source appears with a BLUE tick-mark and the secondary data source appears with a ORANGE tick-mark.
See below:

Reference: https://www.tutorialspoint.com/tableau/tableau_data_blending.htm

NEW QUESTION 85
Which of the following sets would you use to compare the members?

A. None of these
B. Dynamic Sets
C. Static Sets
D. Combined Sets

Answer: D

Explanation: 
You can combine two sets to compare the members. When you combine sets you create a new set containing either the combination of all members, just the
members that exist in both, or members that exist in one set but not the other.
Combining sets allows you to answer complex questions and compare cohorts of your data. For example, to determine the percentage of customers who
purchased both last year and this year, you can combine two sets containing the customers from each year and return only the customers that exist in both sets.
To combine two sets, they must be based on the same dimensions. That is, you can combine a set containing the top customers with another set containing the
customers that purchased last year. However, you cannot combine the top customers set with a top products set.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/sortgroup_sets_create.htm

NEW QUESTION 86
True or False: It is not possible to blend axes for multiple measures into a single axis

A. False
B. True

Answer: A

Explanation: 
 We can very much blend multiple measures into a single axis. Such charts are called Combined-Axis / Blended-Axis charts. Follow along:
Measures can share a single axis so that all the marks are shown in a single pane. To blend multiple measures, drag one measure or axis and drop it onto an
existing axis.
Instead of adding rows and columns to the view, when you blend measures there is a single row or column and all of the values for each measure is shown along
one continuous axis. For example, the view below shows quarterly sales and profit on a shared axis.
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Note: If you drag a measure on to the canvas and only see a single ruler indicator instead of the double ruler indicator shown below, Tableau creates dual axes
instead of a blended axis. For more information about how to create dual axes, see Compare two measures using dual axes.
Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_measures.htm

NEW QUESTION 90
What should you use to apply bold text formatting to rows or columns independent of each other?

A. Text on the Marks card
B. The Field Format Font paneC The Rows tab or the Columns tab on the Format Font pane
C. The Sheets tab on the Format Font pane

Answer: B

Explanation: 
 To apply bold text formatting to rows or columns independently in Tableau, you should use the Rows tab or the Columns tab on the Format Font pane. This
approach provides control over the formatting of text within individual rows or columns. By selecting the appropriate tab (Rows or Columns), you can apply
formatting settings, including bold text, to only the selected rows or columns. This is a crucial feature for enhancing the readability and visual appeal of specific
parts of a Tableau worksheet, allowing for emphasis on particular data points or categories.

NEW QUESTION 94
Using the CoffeeChain table, create a scatter plot of Profit (x-axis) vs Sales (y-axis) broken down by State. Add a Linear trend line to the view. What is its R-
squared value?

A. 0.783262
B. 0.739284
C. 0.759329
D. 0.748472

Answer: A

Explanation: 
 Trend lines have become popular questions in recent Tableau examinations. Follow along:
1) First drag Sales to the Rows shelf and Profit to the Columns shelf:

You will only see a single mark since the view is aggregated.
2) Now, break down this view by state. Drag State into Detail on the Marks shelf ( or directly to the view):

3) Finally, move to the Analytics pane, and drag Trend line to the view. When you drag it, select the Linear option!:
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4) The following is our view. Hover over the trend line to see the R-squared value:

NEW QUESTION 98
You are creating a combined axis chart.
Where should you drag the second measure after dragging the first measure to the Rows shelf?

A. The Filter card
B. The vertical axis in the view
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C. The Marks card
D. The horizontal axis in the view

Answer: D

Explanation: 
 In Tableau, when creating a combined axis chart, after dragging the first measure to the Rows shelf, you should drag the second measure directly onto the
existing axis in the view. This will combine both measures on the same axis, allowing them to share a scale and an axis, which is the essence of a combined axis
chart.

NEW QUESTION 103
True or False: A sheet cannot be used within a story directly. Either sheets should be used within a dashboard, or a dashboard should be used within a story.

A. rue
B. False

Answer: B

Explanation: 
 It is possible in Tableau to use a sheet within a story directly.
Moreover, in Tableau, a story is a sequence of visualizations that work together to convey information. You can create stories to tell a data narrative, provide
context, demonstrate how decisions relate to outcomes, or to simply make a compelling case.
At the same time, a story is also a collection of sheets, arranged in a sequence. Each individual sheet in a story is called a story point.

Reference: https://help.tableau.com/current/pro/desktop/en-us/stories.htm

NEW QUESTION 108
You have a continuous numeric measure named Sales.
Which chart type is created when you double-click the Sales measure?

A. A text table
B. A line chart
C. A pie chart
D. A bar chart

Answer: B

Explanation: 
 When you double-click a continuous numeric measure named Sales in Tableau, it automatically creates a bar chart. Tableau's default behavior for a single
measure is to display it as a bar chart, with the measure values represented on the Y-axis and an automatic range on the X-axis.

NEW QUESTION 110
True or False: Tableau can create worksheet-specific filters
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A. True
B. False

Answer: A

Explanation: 
 Yes, it is possible to create worksheet-specific filters in Tableau.
When you add a filter to a worksheet, by default it applies to the current worksheet. Sometimes, however, you might want to apply the filter to other worksheets in
the workbook.
Then, you can select specific worksheets to apply the filter to or apply it globally to all worksheets that use the same data source or related data sources.
Reference: https://help.tableau.com/current/pro/desktop/en-us/filtering_global.htm

NEW QUESTION 112
Is it possible to add both a Dashboard and a Worksheet at the same time to a Story Point in Tableau?

A. Yes
B. No

Answer: B

Explanation: 
This is a tricky question. We are talking about story POINTS, and not entire stories in the question.
To create a story, lets say I have a blank story with 1 dashboard and 1 worksheet. I can simply drag the dashboard into the view to create a new story point.

Now, if I try to adjust the worksheet beside it in this same view, I cannot. See below:

The only option available is to replace the existing view. Therefore, the answer is NO since
they both cannot be added.
Read more about stories in Tableau: https://help.tableau.com/current/pro/desktop/en- us/story_create.htm

NEW QUESTION 117
Which of the following describes the best way to change the formatting at a workbook
level?

A. Right click anywhere in the view, choose format, and then specify the formatting in the new Format workbook pane.
B. It is only possible to specify formatting at a worksheet level, not at the workbook level.
C. Click on Text in the Marks card, choose format, and then specify the formatting in the new Format workbook pane.
D. Choose Format from the menu on top and then specify the formatting in the new Format workbook pane.

Answer: D

Explanation: 
It is very much possible to specify the formatting at a WORKBOOK level (all sheets) instead of a single worksheet level.
You can quickly change how fonts, titles, and lines look in every view in a workbook by specifying format settings at the workbook level, instead of the worksheet
level.
For example, you might want to use a specific font, size, and color so that all views adhere to your company's brand. You might also want to remove grid lines from
your views—or make them more noticeable by increasing their pixel size or color.
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You can also change the theme used by your workbook. Themes control items like the default font, colors, and line thickness. When you create a new workbook, it
automatically uses the Default theme, which uses visual best practices.
Change fonts in your workbook:
You can change all fonts in your workbook or you can change fonts for only certain areas, such as just worksheet titles.
1) On the Format menu, select Workbook.
2) The Format Workbook pane replaces the Data pane on the left and provides a series of drop-down lists where you can change all font settings in a workbook,
as well as the font settings for titles of worksheets, stories, and dashboards.

Note: If you have made font changes at the worksheet level, such as on a filter card or a worksheet title, changing the font at the WORKBOOK level will overwrite
those changes.

Reset a workbook to its default settings
When you make changes to your workbook's font settings, a gray dot appears next to the setting in the Format Workbook pane. You can quickly switch back to
default settings using the Reset to Defaults button.
1) On the Format menu, select Workbook.
2) In the Format Workbook pane, click Reset to Defaults.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/formatting_workbook.htm

NEW QUESTION 118
Which two elements can have their values changed by using a dashboard action? Choose two.

A. Bins
B. Groups
C. Sets
D. Parameters

Answer: CD

Explanation: 
 In Tableau, the two elements that can have their values changed by using a dashboard action are Sets and Parameters. Dashboard actions can be configured to
modify the values within a set or a parameter, allowing for interactive and dynamic changes in the visualization based on user interactions. For example, selecting
a specific data point in a dashboard can trigger an action that updates a set or changes the value of a parameter, which in turn can alter the displayed data or the
appearance of visualizations within the dashboard.

NEW QUESTION 120
How can you create a packaged data source?

A. From the Worksheet menu, select Export, and then select Data.
B. From the Data pane, right-click the data connection, and then select Add to Saved Data Sources.
C. From the File menu, select Share.
D. From the File menu, select Save As.

Answer: B

Explanation: 
 To create a packaged data source (.tdsx file) in Tableau, you would right- click on the data connection in the Data pane and select the option to add it to saved
data sources. This action packages the data source with the metadata that you've defined in Tableau, such as calculations, groups, and sets, so that you can
easily share it with others. This does not package the data itself, which is a separate step if you're working with local file-based data.

NEW QUESTION 125
For a ______ sort, no matter how the data changes, the values will always stay in the sort order we kept stuff in.

A. Random
B. Manual
C. Topological
D. Hierarchical

Answer: B
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Explanation: 
 For a manual sort, no matter how the data changes, the values will always stay in the sort order you kept stuff in.
From the official website:

Reference: https://help.tableau.com/current/reader/desktop/en-us/reader_sort.htm

NEW QUESTION 130
Using the dataset, create a bar chart showing the average Quantity broken down by Region, and filtered by Country to only show Japan. What was the average
Quantity in the State of Tokyo?

A. 3.000
B. 3.840
C. 3.704
D. 3.500

Answer: C

Explanation: 
 Since we need to focus on 1 country -> Japan, let's filter on it first as follows:
1) Drag Country to the filter shelf, and choose only Japan. Click OK.

2) Read the Question Carefully, we need to break down the visualisation by Region, then by Country, and then by State. So let's do that:
Drag Region to the column shelf, followed by Country. Drill down into Country to include states as well.
Then drag Quantity to the Row Shelf, and change the Aggregation to AVERAGE. The following is our visualisation:
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Now that you think of it, EVEN IF YOU REMOVE THE REGION, THE ANSWER REMAINS
THE SAME. Such elements will be present in the actual exam too, just to make the question sound a little difficult, but actually it is pretty straightforward :)

NEW QUESTION 131
By default, measures placed in a view are aggregated. The type of aggregation applied _______

A. 
is always sum

B. depends on the context of the view
C. is always COUNT
D. is always AVERAGE

Answer: B

Explanation: 
 By default, measures placed in a view are aggregated. Mostly you'll notice that the aggregation is SUM, but not ALWAYS.
The type of aggregation applied varies depending on the context of the view. Reference: https://help.tableau.com/current/pro/desktop/en-
us/calculations_aggregation.htm

NEW QUESTION 132
Dragging a ______ to colour creates distinct colours for each item whereas dragging a _____ to colour creates a gradient

A. Discrete value, Continuous Value
B. Geographic Value, Discrete Value
C. Continuous Value, Discrete Value
D. Longitude, Latitude

Answer: A

Explanation: 
Remember that dragging a discrete value to colour creates distinct colours for each item whereas dragging a continuous value to colour creates a gradient. ( Same
for Map )
From the official documentation:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties_color.htm

NEW QUESTION 135
Given a map, which of the following fields can be placed on Size,Shape,Detail,Color

A. Region, Country, Profit, State
B. Sales, State, Country, Profit
C. Profit, State, Number of Records, Sales
D. Longitude, Country, State, Sales

Answer: B

Explanation: 
 Since Sales is a measure, it can easily be depicted via size.
To drill down and change the level of detail, Country is the correct choice since it
will contain STATE. We can then depict the various states by different shapes such as circle, square etc.
Finally, the Profit can be depicted via a color! Eg - Red for poor and green for excellent profits!
Reference: https://www.tableau.com/learn/tutorials/on-demand/aggregation-granularity-and-ratio-calculations

NEW QUESTION 140
Download the Dataset from: https://drive.google.com/file/d/12AYHfiPWkwBmvH0zbumOURgUX6Az00Rw/view?usp=sh aring
Using the Time Series Table, create a line chart to show Sales over time. Which Month and Year witnessed the lowest Sales?

A. September 2017
B. March 2018
C. December 2017
D. January 2018

Answer: D

Explanation: 
 Follow the steps to get the correct answer : January 2018

? We are talking about dates, so use the Time series sheet as follows:
? Next, the following should be your view and clearly, January 2018 is the lowest point:
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Read more about dates: https://interworks.com/blog/rcurtis/2017/01/30/tableau-deep-dive-dates-introduction-dates/

NEW QUESTION 145
Which of the following are valid ways to make the font more readable in Tableau?

A. Decrease the font size
B. Don't use backgrounds
C. use a clear and readable font
D. Make the Font color sharper / darker than the background
E. Increase the font size

Answer: CDE

Explanation: 
This is one of the most common questions on the Tableau Desktop Specialist Exam. Wrong options -
1) Don't use backgrounds - This is not a solution. What if we want to use backgrounds? We can't just stop using backgrounds to solve this problem.
2) Decrease the font size - Do you think using a smaller font will make the text more readable? No right? Hence, this is wrong too.
All other options are ways recommended to make your text more readable!

NEW QUESTION 148
Which of the following are valid ways to italicize Tooltip content in Tableau?

A. Click on Format in the Menu bar, choose Font, and then edit the Tooltip options to italicize the font
B. Click on Tooltip in the Marks card, select the text, and then use the Italics option
C. Click on Worksheet in the Menu bar, select Tooltip, and then use the italics option
D. Click on Dashboard in the Menu bar, select Tooltip, and then use the italics option

Answer: ABC

Explanation: 
The only incorrect option is - Click on Dashboard in the Menu bar, select Tooltip, and then use the italics option.
This option doesn't exist. See below:

The rest of the options do exist, and therefore are correct:
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NEW QUESTION 150
If you see the following Filter, then you're working with________
Larger image

A. Grouped Dates
B. Date Functions
C. Date Parts
D. Date Values

Answer: D

Explanation: 
Dates in Tableau will behave differently depending on whether they are a Datepart (blue) or a Datevalue (green). This affects how the axes display/behave and
also how visualisations such as line charts will display. The difference essentially boils down to Dateparts behaving like a dimension as opposed to a measure
which is how Datevalues behave. This means that Dateparts behave like discrete categories on the view whereas Datevalues are more like continuous numeric
values.
Dateparts are discrete and they behave the same as dimension filters. If all dates are used on the filter then each individual date will be a datepart that can be
selected/excluded. This is the same for each level of date, if datepart months is placed on filters January to December will be tick-able options in the filter. This
also means that conditions and top/bottom filters can be applied to datepart filters like any other dimension filter. Datevalues placed on filters behave like measure
filters. A min and a max date can be set and there is a relative dates option which allows you to choose things like only show the previous 3 months or years etc.

Reference: https://www.thedataschool.co.uk/harry-cooney/tableau-dateparts-vs- datevalues/

NEW QUESTION 154
True or False: It is possible to add a field to more than one hierarchy

A. True
B. False

Answer: A

Explanation: 
 Yes! It is possible to duplicate a field and add it to more than one hierarchy. Right click and choose duplicate.
Reference: https://www.tableau.com/about/blog/2016/8/take-note-these-10-handy-tableau- shortcuts-57561

NEW QUESTION 156
True or False: When you drag additional tables to the logical layer canvas, Tableau automatically attempts to create the relationship based on existing key
constraints and matching fields to define the relationship. If it can't determine the matching fields, then relating these tables is not possible.

A. True
B. False
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Answer: B

Explanation: 
Tables that you drag to the logical layer of the Data Source page canvas must be related to each other. When you drag additional tables to the logical layer
canvas, Tableau automatically attempts to create the relationship based on existing key constraints and matching fields to define the relationship. If it can't
determine the matching fields, you will need to select them.
If no constraints are detected, a Many-to-many relationship is created and referential
integrity is set to Some records match. These default settings are a safe choice and provide the most a lot of flexibility for your data source.
Reference: https://help.tableau.com/current/server/en-us/datasource_datamodel.htm

NEW QUESTION 157
What are two use cases for a story? Choose two.

A. Provide additional editing and interactive capabilities to your audience.
B. Present a data narrative to lead your audience to your conclusions.
C. Assemble a sequenced analysis to share with collaborators.
D. To allow for easier exporting to Power Point.

Answer: BC

Explanation: 
 You can use a story to present a data narrative to lead your audience to your conclusions, or to assemble a sequenced analysis to share with collaborators. A
story is a sequence of visualizations that work together to convey information. You can create stories to tell a data story, provide context, demonstrate how
decisions relate to outcomes, or to simply make a compelling case4

NEW QUESTION 162
Using the Time Series Table, create a Line chart showing the Monthly Year over Year Growth for the Sales, broken down by Assortment. For the Electronics
assortment, which Month had the most NEGATIVE value of Year over Year Growth?

A. October
B. September
C. July
D. June

Answer: A

Explanation: 

Follow along:
1) Drag Assortment and Year ID (choose Discrete Month) to Columns shelf, and Sales to the Columns Shelf.
For sales, click on the pill -> choose Quick Table calculation -> Year over Year growth.
The view should now look like:

NEW QUESTION 166
Which of the following is a benefit of using a Tableau Data Source (.tds)?

A. To hold one or more worksheets, plus zero or more dashboards and stories.
B. To not contain the actual data but rather the information necessary to connect to the actual data as well as any modifications you've made on top of the actual
data such as changing default properties, creating calculated fields etc
C. To create a single zip file that contains a workbook along with any supporting local file data and background image
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D. This is great for sharing your work with others who don’t have access to the original data.
E. To create a local copy of a subset or entire data set that you can use to share data with others, when you need to work offline, and improve performance.

Answer: B

Explanation: 
The following are the official definitions from the Tableau documentation for the various file types:
1) .tds (Tableau Data Source) - To not contain the actual data but rather the information necessary to connect to the actual data as well as any modifications
you've made on top of the actual data such as changing default properties, creating calculated fields etc. (CORRECT ANSWER)
2) .twbx ( Tableau packaged workbook) - To create a single zip file that contains a workbook along with any supporting local file data and background images. This
is great for sharing your work with others who don’t have access to the original data.
3) Extract (.hyper or .tde) – To create a local copy of a subset or entire data set that you can use to share data with others, when you need to work offline, and
improve performance.
3) (.twb) Workbooks – To hold one or more worksheets, plus zero or more dashboards and stories.
Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 170
You create a crosstab that shows a list of 100 hotel chains alongside their average nightly cost. You also create two groups showing, respectively, the top 10 and
bottom 10 hotel chains by cost, with subtotals.
What should you do to improve the crosstab and compare the two groups to all the
remaining hotel chains?

A. Include an Other group.
B. Include the Summary card.
C. Color encode the hotel chain names.
D. Create a new view.

Answer: A

Explanation: 
 According to the Tableau Help, one of the ways to improve a crosstab is to “Include an Other group”. The help also states that “If you have a large number of
members in a dimension, you can create groups to combine low-frequency members into an Other group. This can help you focus on the most relevant data and
reduce clutter in your view” (page 2).

NEW QUESTION 171
What two methods can you use to change the font of a worksheet title? Choose two.

A. Double-click the title in a particular view and use the dialog box.
B. Right-click the title in a view, and then select Format Title.
C. Select Format on the menu, and then select Font.
D. Select Format on the menu, and then select Title and Caption.

Answer: AD

Explanation: 
 In Tableau, you can change the font of a worksheet title by double-clicking directly on the title in the view, which opens a dialog box where you can format the text,
including changing the font. Another method is to use the Format menu; from there, you select "Title and Caption," which opens the Format Title pane on the left
side of the screen, where you can change the font and other formatting options for the worksheet title.

NEW QUESTION 174
Which type of chart can you create without using a dimension?

A. Stacked bar
B. Highlight table
C. Bar
D. Treemap

Answer: B

Explanation: 
 Bar charts in Tableau do not require a dimension to be created. You can create a bar chart using only a measure; this will produce a single bar that represents the
aggregate of the measure values, such as the sum or average of sales.

NEW QUESTION 176
How can you format an axis as Bold in Tableau?

A. By choosing the axis and selecting Command/Control + B on your keyboard
B. By right clicking on the axis, choosing Edit Axis, and then setting its font to bold.
C. By right clicking on the axis, choosing format, and then setting its font to bold.
D. By clicking on Format on the main menu bar, choosing field labels, and setting it to bold.

Answer: C

Explanation: 
To make an axis bold, simply right click it, select format, and then click on Font to choose Bold:
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None of the other options are valid ways to make the axis bold.

Read more about editing axis: https://help.tableau.com/current/pro/desktop/en- us/formatting_editaxes.htm

NEW QUESTION 181
You want to save a view as an image that you can paste into a Microsoft Word document. Which two statements accurately describe exporting a view as an
image? Choose two.

A. Default exports include everything in the view, including Tableau fonts.
B. The default export format is TIFF.
C. The default export format is PNG.
D. The exported image is a vector-based file that embeds the Tableau fonts.

Answer: AD

Explanation: 
 When exporting a view as an image in Tableau, the default export includes everything that is currently displayed in the view, with Tableau applying its own styling,
including fonts. The default format for an exported image is PNG, which is a raster-based file format that captures all visual elements as pixels. PNG is widely used
for its lossless compression and is suitable for detailed images like those produced by Tableau. Unlike vector-based images, PNGs do not embed fonts, and the
image quality remains consistent when the image is viewed on different platforms, which makes it ideal for inserting into documents like Microsoft Word.

NEW QUESTION 184
______ is a method for appending values (rows) to tables. You can use this method if both tables have the same columns. The result is a virtual table that has the
same columns but extends vertically by adding rows of data.
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A. Joining
B. Blending
C. Combining
D. Unioning

Answer: D

Explanation: 
Unioning is the correct answer! From the official documentation:

For example, suppose you have the following customer purchase information stored in three tables, separated by month. The table names are "May2016" ,
"June2016" and "July2016."

Reference: https://help.tableau.com/current/pro/desktop/en-us/union.htm

NEW QUESTION 189
True or False: Trend lines can only be used with numeric or date fields

A. True
B. False

Answer: A

Explanation: 
 You can show trend lines in a visualization to highlight trends in your data.
To add trend lines to a view, both axes must contain a field that can be interpreted as a number. For example, you cannot add a trend line to a view that has the
Product Category dimension, which contains strings, on the Columns shelf and the Profit measure on the Rows shelf.
However, you can add a trend line to a view of sales over time because both sales and time can be interpreted as numeric values.
Reference: https://help.tableau.com/current/pro/desktop/en-us/trendlines_add.htm

NEW QUESTION 190
The icon associated with the field that has been grouped is a ______

A. Paper Clip
B. Globe
C. Intersection
D. =#

Answer: A

Explanation: 
 You can create a group to combine related members in a field. The icon associated with a group is a paper clip!
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NEW QUESTION 194
Using the CoffeeChain table, create a chart to see the monthly Percent difference change in Profit, from the beginning of 2012 to the end of 2013. How many
months saw a Negative percent difference in Profit?

A. 9
B. 7
C. 10
D. 8

Answer: C

Explanation: 
 Follow along to reach the correct Answer
1) First, drag Date to the Column shelf and Profit to the Rows shelf. We need to see the 2 consecutive months over this two year period (2012-2013) so this tells
us we need to work with continuous dates:
Click on Date in the Column shelf and convert it to continuous month :

2) Now, click on the Profit pill in the Rows shelf, go to quick table calculation and choose Percent difference:
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3) Finally, click on the Show mark Labels icon:

4) We finally have our view, and clearly, 10 Months have a NEGATIVE percent difference:

NEW QUESTION 195
Dimensions containing ________ and ________ values cannot be continuous.

A. Boolean
B. Date
C. Date and Time
D. String

Answer: AD

Explanation: 
 According to Tableau's official documentation -

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 196
Which two options can you use to change the device layout of a dashboard? Choose two.
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A. The Dashboard pane
B. The Format menu
C. The Dashboard menu
D. The Layout pane

Answer: AD

Explanation: 
 You can change the device layout of a dashboard by using the Dashboard pane or the Dashboard menu. The Dashboard pane allows you to select a device type
and customize the layout for that device. The Dashboard menu allows you to create a new device layout or copy an existing one. The Format menu and the Layout
pane do not have options for changing the device layout1

NEW QUESTION 201
Which type of date filter can you use to choose a range of dates based on TODAY ()?

A. Range of dates
B. Relative dates
C. Ending date
D. Starting date

Answer: B

Explanation: 
 The relative date filter can be used to select a range of dates relative to the current date, such as the past month, the current quarter, etc. This filter type
dynamically adjusts the range based on the current system date, making it suitable for use with the TODAY() function.

NEW QUESTION 206
Using the dataset provided, create a crosstab showing the Profit of each Region per Year, then add grand totals to the view. What was the total Profit for Canada
in 2012 and the total Profit for Canada for 2011 through 2014, respectively?

A. 5,129 and 88,872
B. 52,678 and 311,404
C. 1,807 and 34,571
D. 4,888 and 17,817

Answer: D

Explanation: 
 To reach the correct answer, follow these steps:
1) Drag Order Date (Discrete Year) to the Column shelf, and Region to the Row Shelf as shown:

2) Drag Profit to Text in the Marks Shelf as shown:

3) Click on Analysis as shown -> Totals -> SELECT ROW GRAND TOTALS The following will be the final view:

You could also Filter by Region to only Focus on Canada, but that's your choice:
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THEREFORE, 2012 = 4,888
2011 -> 2014 = 17,817

NEW QUESTION 211
From which three locations can you sort a visualization? Choose three.

A. The Worksheet menu
B. Tooltip on the Marks card
C. DCA header
D. The Analysis menu
E. An axis
F. Afield label

Answer: AEF

Explanation: 
 According to the Tableau Desktop Specialist Exam Guide, one of the exam objectives is to “Sort data in a visualization”. The guide also states that “You can sort
data in a visualization from three locations: the Worksheet menu, an axis, or a field label” (page
15).

NEW QUESTION 213
You have the following visualization.

Where should you place a field named Region to show multiple distinct lines on the same axis?

A. Path on the Marks card
B. Color on the Marks card
C. The Columns shelf
D. The Rows shelf

Answer: B
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Explanation: 
 To display multiple distinct lines on the same axis based on a field, you should place the field on the Color shelf in the Marks card. This will encode each distinct
value in the Region field with a different color, resulting in separate lines for each region on the same axis.

NEW QUESTION 215
You need to invert the color intensity of a quantitative range. Which option should you use?

A. Reversed
B. Opacity
C. Border
D. Stepped Color

Answer: A

Explanation: 
To invert the color intensity of a quantitative range in Tableau, you should use the "Reversed" option. This option inverts the color scheme so that the colors
representing the higher values are swapped with those representing the lower values. For example, if a color scale initially shows dark colors for high values and
light colors for low values, using "Reversed" will switch this so that dark colors represent low values and light colors represent high values. This option is
particularly useful for better visual distinction and
interpretation in certain data scenarios.

NEW QUESTION 217
Which of the following is not a Trend Line Model?

A. Linear Trend Line
B. Exponential Trend Line
C. binomial Trend Line
D. Logarithmic Trend Line

Answer: C

Explanation: 
 According to the official Tableau documentation, there are 5 types of trend lines which we
can work with in Tableau :
1) Linear Trend Line
2) Logarithmic Trend Line
3) Exponential Trend Line
4) Polynomial Trend Line
5) Power Model
Hence, the correct answer is BINOMIAL trend line which is not present in Tableau. See the following image:

For more information, refer to: https://help.tableau.com/current/pro/desktop/en- us/trendlines_add.htm
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NEW QUESTION 218
By default, measures placed in a view are aggregated by _____

A. COUNT
B. AVERAGE
C. MEDIAN
D. SUM

Answer: D

Explanation: 
 By default, measures placed in a view are aggregated by SUM, which means that the data for that field in all of the rows is combined. Measures can also be
aggregated as average, median, count, or count distinct.
Reference: https://help.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm

NEW QUESTION 220
DOWNLOAD THE DATASET FROM - https://drive.google.com/file/d/1F8L_Rl5B9LAz8RDi- DdjWx3Iv-SgzaBq/view?usp=sharing ( if you haven't already from the
test instructions page! )
How many different countries are present in the dataset?

A. 150
B. 147
C. 140
D. 156

Answer: B

Explanation: 
Explanation
To reach the correct answer, follow these steps:
1) You can simply drag Country to the view, and look at the marks in the bottom left of Tableau Desktop - 147 marks!

2) Or, you can simply go to Data Source -> Country Tab -> Describe
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As you can see, 147 members exist in this Country column!

NEW QUESTION 222
Which of the following situations describe the best reason to use a union?

A. You have two tables with similarly named columns of data that you want to combine.
B. You have two data sets with similar data types for which you want to find only distinct values.
C. You have two tables with differently named columns of data that you want to combine.
D. You have two data sets saved in different formats that you want to unify into a single format.

Answer: A

Explanation: 
 You should use a union when you have two tables with similarly named columns of data that you want to combine. A union is a method for combining data by
appending rows of one table onto another table. The tables that you union must have the same number of fields, the same field names, and the same data types2

NEW QUESTION 223
Which statement accurately describes an extract when the Physical Tables option is selected?

A. Data is limited to only the Top N of data for the connection.
B. All the data is tolled up to the current visible fields.
C. An individual table is created for each physical table in the extract.
D. Data shown in the Data pane is separated based on the table type.

Answer: C

Explanation: 
 When the Physical Tables option is selected for an extract in Tableau, an individual table is created for each physical table in the extract. This means that the
extract will include a separate table for each underlying table in your database, maintaining the database's structure within the extract. This can be useful when you
need to preserve the original granularity of the data or when working with certain database optimizations.

NEW QUESTION 228
We can join a maximum of _____ tables in Tableau

A. 16
B. 32
C. 64
D. 128

Answer: B

Explanation: 
 It is possible to join a maximum of 32 tables in Tableau!
Reference: https://www.mytectra.com/interview-question/tableau-interview-question-and- answers

NEW QUESTION 231
You want to update the font of an entire workbook. What should you use to configure the default fonts?

A. The Formal Font pane
B. The Format Workbook pane
C. Field labels
D. Titles and captions

Answer: B

Explanation: 
 To update the font of an entire workbook in Tableau, you should use the "Format Workbook" pane. This feature allows you to set and modify the default font
settings for the entire workbook, ensuring consistency in font style across all sheets and dashboards. It's a global setting that applies to all visual elements in the
workbook, including titles, captions, axis labels, and other text elements.

NEW QUESTION 233
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In which situation should you save a workbook as a PDF document?

A. Your users have Tableau Desktop but not Tableau Reader.
B. You want document users to be able to filter and sort the views.
C. Your analysis does not require a live connection to a data source.
D. You need paper copies of the workbook.

Answer: D

Explanation: 
 You should save a workbook as a PDF document if you need paper copies of the workbook. A PDF document preserves the layout and formatting of the
workbook, and can be easily printed or shared. Saving a workbook as a PDF document is not necessary or useful in the other situations1

NEW QUESTION 238
For a relative date filter, the default anchor is ______

A. The current time
B. Today's date
C. The target date
D. The date we specify

Answer: B

Explanation: 
 Relative date filters dynamically update to show a time period relative to when you open
the view, such as the current week, the year to date, or the past 10 days. Relative date filters make it easy to create views that always show the most recent data.
Step 1: Drag a date field to the filter shelf
Right-click (control-click on Mac) and drag a date field from the Data window to the Filters shelf. In the Filter Field dialog box, click Relative Date, and then click
Next.

Step 2: Select a time unit
In the Filter dialog box, click Relative dates, and then select the unit of time for the filter. For example, to show only the three most recent weeks, select Weeks.

Here, you can clearly see that the default date is TODAY
Reference: https://help.tableau.com/current/pro/desktop/en-us/qs_relative_dates.htm

NEW QUESTION 240
Which of the following are valid ways to add Totals to a view?

A. Using the Data Pane
B. Using the Analytics Pane
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C. From the Analysis Tab in the Menu bar on top
D. Using the Marks shelf

Answer: BC

Explanation: 
To add totals to a view using the Analytics pane:
Also, you can add totals from the Analytics tab in the Menu above:

NEW QUESTION 242
Which of the following returns the Absolute Value of a given number?

A. ABS(Number)
B. CEILING(Number)
C. FLOOR(Number)
D. ZN(Number)

Answer: A

Explanation: 
 From the official Tableau website:
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Reference: https://help.tableau.com/current/pro/desktop/en- us/functions_functions_number.htm

NEW QUESTION 247
The row and column shelves contain ______

A. Pills
B. Grand Totals
C. Filters
D. Parameters

Answer: A

Explanation: 
 We can drag fields from the Data pane to create the structure for your visualizations.
The Columns shelf creates the columns of a table, while the Rows shelf creates the rows of a table. You can place any number of fields on these shelves.
These FIELDS are also referred to as PILLS. See below:

Reference: https://help.tableau.com/current/pro/desktop/en-us/buildmanual_shelves.htm

NEW QUESTION 249
Which three statements accurately describe continuous fields? Choose three.

A. Continuous fields appear as green pills.
B. Continuous fields are numeric.
C. The values in continuous fields are treated as an infinite range.
D. Continuous fields are categorical
E. Only measures can appear as continuous.

Answer: ABC
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Explanation: 
 Continuous fields in Tableau have specific characteristics:
? A. Continuous fields appear as green pills:
? B. Continuous fields are numeric:
? C. The values in continuous fields are treated as an infinite range: Incorrect options:
? D. Continuous fields are categorical: This is incorrect because categorical fields are discrete, not continuous.
? E. Only measures can appear as continuous: This is incorrect because dimensions can also be treated as continuous in certain contexts.
References:
? Tableau's official documentation on continuous and discrete fields: Continuous and Discrete

NEW QUESTION 253
You have the following visualization.
You need to show how Internet Usage values change from year-to-year as a percentage. Which quick table calculation should you apply to the Internet Usage
field?

A. Compound
B. growth rate
C. Percent difference
D. Difference
E. Percentile

Answer: B

Explanation: 
 To show how Internet Usage values change from year to year as a percentage, you should apply the "Percent Difference" quick table calculation to the Internet
Usage field. This calculation compares each value to the previous value and computes the difference as a percentage, which is ideal for analyzing the rate of
change over a sequential time period such as consecutive years.

NEW QUESTION 256
Which of the following are the options to export the data used to build the view / visualisations?

A. CSV file
B. PDF File
C. JSON format
D. MS Access Database

Answer: AD

Explanation: 
 You can export the data in a Tableau data source, including all or part of the records from your original data. Alternatively, you can export only the portion of data
used to generate the view.
Since the question mentions the data used to build the view, we'll focus on that :
*Export data in the view to Microsoft Access or .csv*
Export the data that is used to generate the view as an Access database (Windows only) or
.csv file (Mac only).
1) In Tableau Desktop, select Worksheet > Export > Data.
2) Select a location and type a name for your Access database or .csv file.
3) Click Save.
4) If you're on Windows, the Export Data to Access dialog box displays to give you the option to immediately use the new Access database and continue working
in Access without interrupting your work flow.

Reference: https://help.tableau.com/current/pro/desktop/en-us/save_export_data.htm

NEW QUESTION 259
Which of the following shapes does a Heat Map use by default?

A. Square
B. Line
C. Text
D. Circle

Answer: A

Explanation: 
By default, the shape that a Heap map uses is a "Square". See below:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/buildexamples_highlight.htm

NEW QUESTION 264
What will the following function return?
LEFT("Tableau", 3)

A. An error
B. Tab
C. eau
D. ble

Answer: B

Explanation: 
 The following is the official documentation for the String function LEFT:

Reference: https://help.tableau.com/current/pro/desktop/en- us/functions_functions_string.htm

NEW QUESTION 268
What are two examples of a date value? Choose two.

A. 2020-05-01
B. December
C. Wednesday
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D. January 1.1995

Answer: AD

Explanation: 
 Date values in Tableau represent specific points in time and are typically formatted in a standard date format.
? Option A, "2020-05-01", is a standard date format representing the 1st of May, 2020.
? Option D, "January 1, 1995", is another example of a date value, representing the 1st of January, 1995. Options B ("December") and C ("Wednesday") represent
a month and a day of the week, respectively, but do not specify a particular date.

NEW QUESTION 269
Which three statements accurately describe dimensions? Choose three.

A. Contain qualitative values
B. Affect the level of detail in the view
C. Contain numeric, quantitative values
D. Can be continuous or discrete
E. Affect the formatting options in the view

Answer: ABE

Explanation: 
 Three statements that accurately describe dimensions are: Contain qualitative values Affect the level of detail in the view Can be continuous or discrete
Dimensions are fields that contain qualitative values, such as names, dates, or geographical data. You can use dimensions to categorize, segment, and reveal the
details in your data. Dimensions affect the level of detail in the view by creating headers or labels for marks or by defining how data is partitioned for table
calculations. Dimensions can be continuous or discrete depending on their data type and format. Continuous dimensions are those that have an infinite range of
possible values, such as numbers or ratios. Discrete dimensions are those that have a finite number of distinct values, such as names, categories, or dates3 The
other options are not accurate statements about dimensions. Contain numeric, quantitative values is not correct, because fields that contain numeric, quantitative
values are measures, not dimensions. Measures are fields that contain numeric values that you can measure and aggregate. Affect the formatting options in the
view is not correct, because formatting options are not determined by dimensions, but rather by user preferences and choices. Formatting options allow you to
change the appearance of various elements in the workbook, such as fonts, borders, shading, alignment, etc3

NEW QUESTION 273
Which aggregation is available without requiring a table calculation or calculated field?

A. Running total
B. Standard deviation
C. Sample covariance
D. Percent of total

Answer: B

Explanation: 
 Standard deviation is an aggregation that is available without requiring a table calculation or calculated field. Standard deviation is a statistical measure that shows
how much variation there is from the average value in a set of data. Standard deviation is one of the predefined aggregations in Tableau that can be applied to any
measure by selecting it from the context menu of the measure or from the drop-down menu on the Marks card6 The other options are not aggregations that are
available without requiring a table calculation or calculated field. Running total, sample covariance, and percent of total are all examples of table calculations,
which are computations that are applied to the values in an entire table or partition of a table. Table calculations can be created by selecting them from the context
menu of a measure or by using functions in a calculated field7
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